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Overview     
Overview
This program was designed to help farmers to operate their farms efficiently and with 
greater profitability. 

This manual describes how to set up and use the Farm Works® View software.

Windows Vista and Windows 7 operating system setup
The software works with the Windows Vista® and Windows® 7 operating systems. To 
configure it, do one of the following:

Run as an administrator

1. Right-click the software icon and then select Properties.

2. In the Compatibility tab, select Run this program as an administrator and then 
click OK:

3. When you start the software, the system prompts you for permission to run it.

Disable user accounts on the computer

1. From the Start menu, select Control Panel / User Accounts.

2. Select Turn User Control On/Off and then click OK.

3. Restart the computer.
Farm Works View Software Reference Guide     5



 Overview
Note – Microsoft recommends that you keep this new security feature turned on. Be aware 

that you are removing a level of protection by disabling User Account Control alerts, and 

you are also disabling the Internet Explorer® protected mode. 

Registering the software
To obtain full use of the software, and to receive information on future upgrades, you 
must register using the owner’s name with a number provided to you by the software. 
Registration takes just a few moments to complete.

Online registration 

1. When you see the registration dialog, select Get Registered Immediately....

2. Make sure that the computer is connected to the Internet and then click Next.

3. Enter all of the requested information and then click Next. A message indicates 
successful registration.
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Other registration options

If you prefer, use one of the other registration options:

• Complete the online form: Select Obtain registration number using an online form 

to obtain registration numbers using the online form. Once you complete the 
form, you will receive the registration numbers by email. You can then select the 
option to enter the registration numbers from the email. 
To register online go to www.farmworks.com/register.

• Enter numbers you previously received: Select the final option if you obtained 
registration numbers from another source (such as a dealer, by contacting 
technical support, or when you have completed the online form). Click Next and 
then enter the registration numbers in the appropriate fields for each of the 
applications that you own.   

• Registering the software by phone:

– North America: +1 800-282-4103

– Europe: +44 1786-465100

– Australia: + 61 386807222

– Other countries: +1 260-488-3492

Running the software for the first time

Selecting a measurement system

The first time you open the program, you are prompted to select a measurement 
system:

Select the required option and then click OK. The options are:

• US-English

• Metric 
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• Show All Units. This shows US and Metric units—the software uses the first 
selection (US-English or Metrics) for area and distance measurements, but gives 
both US-English and Metrics for any volume measurements.

Note – The Show All Units option is suitable for users in Canada who want US distance 

and area measurements and metric volume and quantity measurements.

Starting the software
To start the software, do one of the following:

• Select Start / All Programs / View software. 

• Double-click the View icon on the Windows desktop.   

The program opens a new project so that you can begin working in it, or you can select 
File / Restore Backup to restore a backup of a project that you made previously. 

For instructions on restoring a backup of a project, see below. 

Backing up projects
To safeguard your data, Farm Works recommends that you make regular and frequent 
backups of your project to a medium other than your hard drive (USB, CD, hard disk, 
and so on) in case of failure, loss, or damage. This enables you to restore the backup of 
your project and recover lost data. Without a project backup, there is no way to recover 
the records and maps for your farm. 

1. Select File / Backup Project.

2. Enter a name for the backup in the Backup To field, or replace an earlier backup 
by selecting it from the drop-down list:
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By default, the program saves project backups in the backup folder on the computer 
hard drive (c:\program files\farmproj\ez-office).  To save the backup to a different 
folder or to a removable drive:

1. In the Backup Project dialog, click the Browse button.

2. In the Save As dialog, do one of the following:

– Select the required folder or removable drive from the Save In list.

– Select an icon in the left-hand column of the dialog and then browse to the 
folder or drive where you want to save the backup ( for example, to save the 
backup to a USB drive, select the My Computer icon, select the letter for the 
removable drive to enter it in the Save In field.

3. Enter a name for the backup file in the File Name field, or replace an earlier 
backup by selecting it from the drop-down list. 

4. Do one of the following:

– Click Save to return to the Backup Project dialog.

– Click Cancel to close the dialog without saving the backup.

5. In the Options section of the Backup Project dialog, select a value from the 
Compression drop-down list to change the size of the backup file and the 
amount of time it will take to create the backup. The options are Maximum 
(slowest), Normal (default), Fast, Super Fast, or None:

– If you select Maximum, the program will take longer to create the backup 
but the file will be smaller. 

– If you select None, the program will take a shorter time to create the 
backup, but the file will be much larger.

6. If you are saving the backup to a USB drive or a disk, you can select Wipe Disk 
from the Disk Prep drop-down list to erase all files on the USB drive or floppy 
disk before making the backup. 

C CAUTION – Before you select Wipe Disk, verify there are no files you want to keep.

7. You can also select to include:

– Backdrops and /or Sire Mobile archived data. 

– Trac Mate and Site Mate archived data.  This will back up any raw data that 
you have collected (and imported into the View software) with the Trac 
Mate and/or Site Mate programs.

Note – Backdrops include aerial images and digital photos. Site Mobile data is a copy of 

the original, raw data.
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8. Click OK. A progress screen appears:

Click Cancel to close the dialog without making a backup.

9. Repeat the procedure steps to save another backup to a different folder, 
removable drive, or floppy disk.

Restoring project backups

If your data is corrupted or if you lose your data through a hardware failure, you can 
attempt to recover data by restoring a backup you created earlier with the backup 
option (as described above). 

Note – The program will not restore backups made with other software, such as the 

Windows XP backup utility.

Restoring a project backup replaces the information in the current project with the 
information that you had at the time you made the backup. For example, if you created 
a backup on Monday, and then needed to restore it on Friday of the same week, you 
will lose any information entered Tuesday through Thursday of that week.

1. Select File / Restore Backup:

2. From the Backup Project drop-down list, select the backup file you created 
previously. If the backup does not appear on the list, browse to locate it:

a. Click the Browse button to open a second Restore Backup dialog.
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b. Do one of the following:

– Browse to the folder or drive where you previously saved the backup.

– Select an icon in the left-hand column and then browse to the folder 
or removable drive where you previously saved the backup ( for 
example, if you saved the backup to your My Documents folder, select 
the My Documents icon to transfer it to the Look In field).

3. Select the backup file— it moves to the File Name field—and then click Open:

4. In the Restore Backup dialog, the backup file now appears in the Restore From 
field:

5. Select the Project Name that you want to restore the backup to. 

Note – If you selected Restore Backup from the File menu, you cannot restore to the project 

that you were previously in. To restore to this project, exit the software, restart it and then 

click Restore Project in the Project Selection tab.

6. Do one of the following:

– Click OK to restore the file.

– Click Cancel to close the dialog without restoring the backup.

7. If you click OK, you are prompted to confirm the restore operation: 

8. Click OK. A progress screen appears:

Click Cancel to close the dialog without making a backup.

During the restoration of the backup, the program replaces the current data in your 
project with the data in the backup file. When the restoration is complete, you can 
begin working with the restored data.
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Changing user information
The contact information that is printed on many reports is sourced from the user 
information entered in the program. To change this:

1. Select File / Preferences / User Info. 

2. In the User Information dialog, select the tabs in turn to enter the details that you 
want to appear on printed reports and then click OK:
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Adding Clients, Farms and Fields, 
Workers, and Commodities 

Before importing information to the program, add your clients, farms and fields, 
people, and commodities to the program. 

To do this, enter the names of your clients and farms, and the names, legal acres, and 
tillable acres for your fields. If required, you may add additional details for your fields, 
such as FSA information.

To set up workers (such as employees), you only need to enter general information 
such as their name. If required, you may add additional data, including addresses and 
license numbers.

Using the toolbar

Click this icon ... To ...

New Client

Add new clients to the program.

New Farm

Add new farms to the program.

New Field

Add new fields to the program.

New Person

Add laborers, employees, and other workers.

Read Job Data

Import data collected with a precision agriculture hardware device, such as an 
EZ-Guide® 500 lightbar or a Trimble® FmX® integrated display.

Write Job Data

Export setup information (for example, Clients, Farms, and Fields) for use with a 
precision agriculture hardware device, such as an EZ-Guide 500 lightbar or a Trimble 
FmX integrated display.
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Setting up clients
You can create clients for custom applicators, fertilizer dealers, consultants, and others 
who want to keep maps and records for clients/customers. 

If you are a grower, you can set up a single client for yourself. Clients show under the 
farm field with fields and farms listed under each.

To add a client:

1. Do one of the following:

– In the Farm tab, right-click <User Info> and then select New Client.

– Click the New Client icon : 

2. In the Client Properties dialog, enter the required information in the General, 
Address, and Contact information tabs:

3. Click OK. The new client appears as a new folder:
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You can now do any of the following:

• Create farm(s) and field(s) under the new client.

You can also create clients when adding farms and fields, see the following 
sections. 

• View and/or modify a client's information. To do this, right-click the name and 
then select Properties.

• Delete a client. To do this, right-click the name, select Delete and then click Yes 
in the warning message that appears. The client and all their associated records 
and maps are deleted. 

Setting up farms
The program allows you to create farms in which to group your fields. Multiple farms 
are generally created with different landlords, so you can organize your fields by farm 
name. 

Once you have added farms to the Farm tab, you can begin adding your fields. You can 
also move fields that you previously added to the program to a farm.   

To add a new farm:

1. Do one of the following:

– Select Resources / New Farm.

– In the Farm tab, right-click <User Info> and then select New Farm.

– Click the New Farm icon : 
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2. Enter a name for the farm in the Description field. 

Note – The area fields are not available—the Mapped, Legal and Tillable areas are filled 

in based of the values that are entered for each field that is set up under the farm.

3. If required, you can enter any miscellaneous information for the farm (up to 255 
characters) in Notes. 

You can now do any of the following:

• Add fields under each farm. 

• View and/or modify a farm’s information. To do this, right-click the name and 
then select Properties.

• Delete a farm. To do this, right-click the name, select Delete and then click Yes in 
the warning message that appears. The farm and all its associated records and 
maps are deleted.

You cannot delete farms for which you have recorded farming operations. 
However, you can then retire the farm. 

If you delete all of the jobs associated with a farm, you will then be able to delete 
the farm. 

• Retire a farm. To do this, right-click the name, select Retire and then click Yes in 
the warning message that appears. The program adds an asterisk to the farm's 
name or removes the field from the Farm field. The software keeps the retired 
farm's farming history in case you need to see it in the future. To display/hide 
retired farms in the Farm field, select View / Show Retired Land Areas.
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Setting up fields
Once farms are set up, you can set up fields so that you can begin recording farming 
operations. You only need to enter the field names, tillable and legal acres for your 
fields, and indicate whether you own, cash rent or share crop the fields. 

Optional information (as identified) can be entered and is used for field records if you 
upgrade to full field-recording programs (such as the Farm Trac module in the Farm 
Works software).

The software enables you to group your fields by farm. 

You can also add new farms to the Farm tab. 

To add a new field:

1. Do one of the following:

– Select Resources / New Field.

– In the Farm tab, right-click the farm to which you are adding the field and 
then select New Field.

– Click the New Field icon : 

2. In the General tab:

a. Enter a name for the field in the Description field. 

b. In Area, enter the Legal and Tillable acres. Tillable acres (required) are used 
in field records; mapped acres are calculated automatically from mapped 
boundaries. 
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c. In Owner/Landlord, select the Client and Farm the field belongs to. You may 
select <Unknown Farm> if you do not know the name of the farm or select 
<Add> to add a farm that is not in the list. 

d. Select whether the field is Owned, Cash Rented, or Share Cropped.

3. Optional. In the Info tab:

a. Select the appropriate County where the field resides, or select <Add/Edit> 
to add a county to the drop-down list. In the Counties dialog, click Add, 
enter a name, and then click OK. 

b. In the FSA area, enter the FSA Farm #, Field #, Track #, and Land Class.

c. In the Legal area, enter the Section #, Township #, and Range # and enter a 
Description (if required). 

4. Optional. In the Photo tab, you can add photographs of your field(s) taken with a 
digital camera or scanned. Click Change, browse to the required photo on your 
system, and then click Open. You can Change, Remove, or Print photos as 
required. Images may be a BMP, JPG, TIF, or PCX file. The photos are used for 
reference purposes only, they will not appear on maps or in other areas.

Removing a photograph will not delete the image file from your computer's hard 
drive or removable drive.

5. Click OK.

You can now do any of the following:

• Add more fields under each farm. 

• View and/or modify a field’s information. To do this, right-click the name and 
then select Properties. This includes moving a field from the <Unknown> farm to 
a different farm by selecting the name of a farm you added in the Farm list.

• Delete a field. To do this, right-click the name, select Delete and then click Yes in 
the warning message that appears. The field and all its associated records and 
maps are deleted.

You cannot delete fields for which you have recorded farming operations. 
However, you can retire the field. 

If you delete all of the jobs associated with a field, you will then be able to delete 
the field. 

• Retire a field. To do this, right-click the name, select Retire and then click Yes in 
the warning message that appears. The program adds an asterisk to the field’s 
name. The software keeps the retired field’s farming history in case you need to 
see it in the future. To display/hide retired fields, select View / Show Retired Land 

Areas.
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Setting up people 
You can use the program to track the operations your employees or other workers 
perform.  

To add a new worker:

1. Do one of the following:

– Select Resources / New Person.

– Click the New Person icon : 

2. In the General tab, you must enter a First and Last name—all other information 
is optional. 

The Full Name and Sorted Name default but may be changed if required. The 
Sorted Name shows in all the lists within the program.

3. Optional. In the General tab:

a. Select the Business check box to add a name of a business as a contact.

b. Select the person's Title.

c. Complete the required Name fields.

d. Enter the Business name, Job Title, and Tax ID.

4. Optional. In the Address tab, complete the fields to provide a mailing address 
and /or street address for the person.
Farm Works View Software Reference Guide     19



 Adding Clients, Farms and Fields, Workers, and Commodities
5. Optional. In the Contact tab, enter relative contact information by completing 
the Phone and Internet areas.

6. Optional. In the Employee tab:

a. Enter a license number if the employee has a pesticide applicator’s license. 
This number appears on the Job Report.

b. Enter the charge Rate in dollars per hour that the employee gets paid. This 
information is used for costing purposes on the Job Report.

7. Optional. In the Photo tab, you can add photographs of the person. Click 
Change, browse to the required photo on your system, and then click Open. 
You can Change, Remove, or Print photos as required.

8. Click OK.

You can now do any of the following:

• Add more persons. 

• View and/or modify a person’s information. To do this, right-click the name and 
then select Properties. 

• Delete a person. To do this, right-click the name, select Delete and then click Yes 
in the warning message that appears. The person and all their associated 
records and maps are deleted.

You cannot delete persons you used in a job. However, you can retire them. 

If you delete all of the jobs associated with a person, you will then be able to 
delete the person. 

• Retire a person. To do this, right-click the name, select Retire and then click Yes 
in the warning message that appears. The program adds an asterisk to the 
person’s name. The software keeps the retired person’s work history in case you 
need to see it in the future. To display/hide retired persons, select View / Show 

Retired Inputs.
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Adding/Editing commodities
Commodities that are used in the program have properties associated with them that 
you can edit. The program has a long list of pre-entered commodities from which you 
can choose. Once you have chosen them, they appear in lists as active.

To edit commodity properties:

1. Select Resources / Commodities:

Any commodities that are currently used, appear in the list. 

2. To add a commodity, click Add:
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3. Select the required commodity from the list or select <New> to add your own 
commodity and then click OK:

4. Make sure that the information in the Commodity Properties dialog is accurate 
(if not, make the required changes), enter a Value and then click OK:

– Units are the harvested units of the commodity.

– Density and Standard Moisture are used to calculate dry quantities when 
harvesting. Moisture should be the moisture that dry weight is calculated 
from. This information can be received from your local elevator or 
wherever you deliver your grain.

These values are used for yield mapping and detailed harvest records 
(including scale tickets) if you upgrade to a full crop recording and mapping 
program (such as the Farm Trac and Farm Site modules in the rom Farm 
Works software).

– Value of the commodity is used on reports.

– Color is shown on the map where that commodity is being grown.
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Adding/Editing job types   
Job types are simply a way to sort through the many operations that take place 
throughout the year and can be queried for reports and editing. The software has a 
predefined set of job types that you can edit or you can add other job types as required.

To add/edit job types:

1. Select Resources / Job Types:

The Operation Types dialog appears. This lists the job types that are currently 
used.

2. To add a job type:

a. Click Add:

b. Enter a Description.

c. Select the Operation Type your description falls under and select the 
pattern to be associated with the operation type. 
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Patterns are used for mapping purposes (so that you can see a map of the 
fields that have different types of operations). These patterns are used if you 
upgrade to other Farm Works software. 

d. Click OK.

3. To delete a job type, select it and then click Delete.
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Importing and Viewing Jobs
You can import jobs from a wide range of precision agriculture devices that record job 
and map data. The software enables you to view these maps, add inputs to the jobs, 
and print job reports. It also allows you to export these jobs in several formats. 

When reading job data, the program reads (and creates maps and field records) for any 
data that is available. This can include a job coverage map, field boundaries, and 
guidance paths.

Importing data
You can bring data in from a wide range of precision agriculture devices to use in your 
project. This may be called importing or reading data.

Reading job data from a USB or other drive

1. Have the job data available on a removable device, such as a USB drive or data 
card. 

2. Insert the device into the computer. 

3. Copy the data to your hard drive as a backup. You can then read the data from 
either the device or the hard drive.

To read (import) job data:

1. Do one of the following:

– Select File / Read Task Data.
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– From the Job / Resource Tools toolbar, click the Read Job Data icon :

The Read Job field lists the precision agriculture devices that you selected when 
you first installed the View software.  If a device is missing from the list, select 
Help / Check for Updates. In the Check for Updates field, select the Show all 

available components check box—the program lists all the supported precision 
agriculture devices.  To add a device to the program (so that it will appear in the 
Read Job Data and Write Job Data fields), select it and then click OK button:
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2. Select the type of data to read. Do one of the following:

– If the data is still on a removable device select Memory Drive and then 
select the drive letter of the device.

– If the data is on the hard drive, select Application Logs, click Browse and 
then navigate to the correct folder. For Trimble data, you must select the 
AgGPS folder for the jobs to appear in the selection window.

When you read job data, the program recognizes the Clients, Farms, and Fields 
that were used on the device in the field. If these names match exactly to the 
names in the software, the program automatically assigns the jobs to the 
appropriate field. If the device has Clients, Farms, or Fields that were not set up 
in the desktop software, you can link them to an existing Client, Farm, or Field 
( for example, if the name was spelled differently on the device), or you can add 
them as a new Client, Farm, or Field. If you selected Skip confirming farm/field 

information, the software automatically creates new Clients, Farms, and Fields 
for any information that does not exactly match what was set up in the software.

3. Select the job(s) to import and then click OK.

4. If the job being imported is a type that does not exactly match a job type that 
you have set up, the Linker : job types dialog appears. Use this dialog to link the 
job type from the file being imported (shown in the Operation Resources list) to a 
job type that is already set up in the View software (shown in the Desktop 

Resources list).  To create a new job type for the Operation Resource, click Create: 

If the job being imported is in a field that has not been created or if the spelling 
is different, and you did not select Skip confirming farm/field information, the 
Linker dialog also appears.
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5. Here, you can create a new Field or link the new Field with one already created. 
Once linked, all subsequent jobs with that Field name will be linked to the 
selected Field. To link a Field:

a. Select the name of the field (as it was created on the field device) from the 
Operation Resources on the left. 

b. Select the field that you created in the software (as explained earlier in this 
manual) from the Desktop Resources on the right. 

c. Click Link. The data is linked to the appropriate field.

6. If you select Create, you must enter Client, Farm, and Field properties if they are 
new. Notice that the program automatically fills in the names based on the 
folder structure and what was collected on the unit. Add any additional 
information as necessary. Additionally, if the data includes a boundary for the 
field, the program will fill in the size of the field:

7. When you have finished linking all new fields, press OK.

8. The job(s) has been imported into the program and will display on the Farm tab 
as well as on the Job tab. 

9. If the job being imported is an application or planting job that has a supply and 
this supply does not exactly match a supply that you have set up, the Linker: 

supplies dialog appears. Use this dialog to link the supplies from the file being 
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imported (shown in the Operation Resources list) to supplies that are already set 
up in the View software (shown in the Desktop Resources list). To create a new 
supply, click Create:

10. Alternatively, if you leave the supply linked to <New> and then click OK, the 
program prompts you to set up a new supply.  Use the Supply Properties dialog to 
enter information about the supply, including the Units of Measure and other 
information:
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Viewing jobs on the Map tab
Once you have imported jobs into the program, you can view coverage data, yield 
maps, guidance lines, field boundaries, and other maps in the Map tab. You can also 
view the information tied to those maps on the Information tab at the bottom of the 
map screen.

Using the Map toolbar

Use the icons on the Map toolbar to change the views of maps of your fields.

Click this icon ... To ...

Select

Select objects in the Map field. Use this to select items in a rectangle by clicking and 
dragging or by single clicking an object. 

Pan

Click and drag the map to view objects not on the screen.

Zoom

Zoom in or out—left click to zoom in and right click to zoom out. The map centers 
where you click. You can also click and drag to zoom into a specifically sized area. 

Zoom in

Zooms closer without re-centering the map.

Zoom out

Zooms out without re-centering the map.

Zoom layer

Zooms the active layer into view.

Zoom all

 Zoom All zooms to the extent of all displayed layers on the map. 

 

Print

Prints the currently displayed map.

Animation

Stop animation

Display a map in the order that it was created/driven. 

When you select the animation tool, the program starts to repaint the 
map on the screen.  Click the Stop animation icon to stop this process at 
any time.

Click the down arrow to select an option to speed up or slow down the 
replay of the map.
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If a field has a boundary that has been mapped, select the Client, Farm, or Field in the 
tree menu to the left to show all of the boundaries mapped during jobs. The size of the 
field boundary appears below the legend:

You can do the following in the Map tab:

• To view a job map, do one of the following:

– Locate the job in the Farm tab and then double-
click it to display the job in the Map tab. 

– In the Job or Map tab, select the View column.
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• Depending on the type of job displayed and the data collected, different data are 
associated with the map. Select the layers tab at the bottom of the Map tab. In 
the Views area, you can highlight the views to display the different data 
associated with the job. The legend automatically updates as you select each 
view:

• To remove the job from the Map screen, clear the check box next to the field in 
the View column of the Job tab. 
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• To view data associated with the map, select an item(s) on the map and then go 
to the Information tab. If multiple items are selected, this tab shows the average, 
minimum, and maximum values:

• To view guidance lines or point, line, and area features that were created with 
the job, select the appropriate option from the drop-down list:
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• To see information on a guidance line, select an individual line on the map and 
then view it in the Information tab:
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Modifying and Managing Jobs 

Finding an existing job
• In the Farm tab, click + to open the client tree and navigate to the recorded job.

• In the Jobs tab, use the sorting and filtering options to display only the jobs that 
meet the criteria of the job for which you are searching.

Modifying a job
1. Once you have found a job, do one of the following:

– In the Farm tab, right-click the job and then select Properties.

– In the Jobs tab, click Properties:

2. In the Job Properties dialog, delete or change the required properties.

To delete an entire job, right-click it in the Farm or Job tab and then select Delete.

Using the Jobs tab
When you select the Jobs tab, all the jobs you have imported into the program are 
listed; there is a separate row for each job. The columns (including, the Job Name, Date, 
Client, and other columns) show specific information for each job. 
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You can do the following in the Jobs tab:

• Sort the listed jobs. To do this, select the appropriate column header, for 
example, click Field to sort the jobs by field name.

To reverse the order of the jobs, select a column header a second time, for 
example, if you click the Date column once, the newest jobs are at the top; if you 
click it the second time, the oldest jobs are at the top.

• To widen or narrow a column, move your cursor over the space between the 
column header until it changes to a cursor with two arrows  and then hold 
the left mouse button down as you drag your mouse to the left or right.

• Use the filter to display only certain jobs. To view the jobs for only one client, 
farm, or field:

a. In the Farm tab, click the + next to the client or farm icon for the jobs you 
want to display. 

b. Select the Filter Jobs by Farm check box at the top of the Farm field to 
display only the jobs for that farm in the Jobs tab.

c. If you select a specific field icon in the Farm tab, only the operations for that 
field appear in the Jobs tab.

d. To remove the filter, clear the Filter Jobs by Farm check box. The program 
displays all of the jobs for all of the fields in the Jobs tab.

• To filter jobs by a date range, or by other criteria, click Edit Filter in the Jobs tab 
to open the Job Filter dialog. Select the check boxes for each property you want 
to add to the filter. You can filter jobs by different criteria and then click OK to 
display only those jobs that meet the criteria:

– To filter jobs by a particular date range, select the Date Range check box 
and then enter the required dates in the From and To fields.

– To filter jobs by any of the other criteria, select the check boxes beside the 
property and enter or select the values to filter.

To remove criteria from the job filter, clear the check boxes.

• To edit filtered items, click Edit Filter and then make the required changes.

• To remove a filter, click Clear Filter. 

Note – It is possible to apply a filter that does not show any jobs in the list. If the job list is 

blank, click Clear Filter to show all of the jobs again.

• To merge two or more different jobs, of the same type and crop and in the same 
Field, highlight all the jobs in the Jobs tab by holding down the Ctrl key and then 
clicking Merge. The multiple entries in the jobs list are now only listed as one. If 
you right-click the new job, it shows a separate column for each job that was 
merged, as well as a Total column.

• To delete a job, click Delete. Once a job has been removed, it cannot be 

recovered
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• To view or edit the details of a job, click Properties.

Using the View menu
Use the View menu to set your viewing preferences for the Farm and Input tabs—you 
can show or hide items such as retired land areas, retired machines, people, or supplies.

To show items, select the required item from the View menu—a checkmark appears 
next to the menu item, and an asterisk appears next to the item in the Farm tab: 

To hide items, select the required item again—the checkmark disappears.
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Writing Job Data
The program allows you to write (export) job data for use with different precision 
agriculture devices, for example, when setting up a device for the first time or when 
using multiple devices. Clients, Farms, and Fields are created on the device from the 
structure you have in the software. The software also exports any guidance lines and 
People that were imported so that you can share them with another unit. When you 
write job data, you can choose which items to export.

Writing job data to an external device
1. Click the Write Job Data icon :

2. Insert a USB drive or other external storage device that you want to export the 
data to.

3. Click Browse and then choose the export location. 

4. Click Resource List to limit the items that will be written.

5. Select each item to export: A check mark appears next to it in the list. This will 
create the Client, Farm, and Field structure on the device.

6. Click OK. The program creates the necessary files and folders that are required 
by the selected precision agriculture device. You can then import that data into 
a company device.
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Printing Maps 
In the Map tab, click the Map Report icon   to preview the map as it appears. The 
Map Report includes basic summary information for any job that is displayed 
(including the Client, Farm, Field, and so on). In addition, the Map Report includes the 
legend that was used in the Map tab: 

Click the print icon  in the report preview to print the map.
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